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RESUMEN 

TITULO: EFECTO JOULE POR APLICACIÓN DE RADIOFRECUENCIA EN NANO-

PARTÍCULAS METÁLICAS INMERSAS EN SOLUCIONES ACUOSAS1 

AUTOR: JORGE ANDRÉS MIDEROS ARBOLEDA2 

PALABRAS CLAVE: Nano-partículas metálicas, campo electromagnético de 

radiofrecuencia, efecto joule, simulación numérica multifísica. 

DESCRIPCIÓN: En el presente trabajo de grado se abordará la teoría de los 

campos electromagnéticos y la Ley de Joule. Con base en esta teoría se 

desarrollarán unas simulaciones numéricas de una solución acuosa que contiene 

una o más partículas metálicas mientras se aplica un campo de radiofrecuencia. Se 

analizará el comportamiento térmico a partir de la variación del nivel de 

concentración y el tamaño de las partículas. Se tomará como punto de partida, la 

literatura científica que esté relacionada con el efecto de campos electromagnéticos 

de radiofrecuencias en el calentamiento de soluciones con nano-partículas 

metálicas. Se realizará el proceso de simulación utilizando el software comercial 

CST Studio Suite (Computer Simulation Technology) en el ambiente multifísico, para 

describir el fenómeno de campo electromagnético y de variación térmica, por medio 

de las ecuaciones de Maxwell y de difusión térmica, respectivamente. El 

acoplamiento de ambos grupos de ecuaciones se produce a través del cálculo de 

las pérdidas de energía electromagnética. Los resultados obtenidos en este trabajo 

de grado serían de interés para posteriores investigaciones en ingeniería biomédica 

en áreas como: el tratamiento hipertérmico de células cancerígenas que 

complementa otros tratamientos como la quimioterapia y la radioterapia; las terapias 

rápidas en lesiones musculares en atletas y de otras condiciones reumáticas.  

                                            

1 Trabajo de grado 
2 Facultad de Ingenierías Físico-mecánicas. Escuela de Ingenierías Eléctrica, Electrónica y 
de Telecomunicaciones. Director: Doctor en Ingeniería Ernesto Aguilera Bermúdez. 
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ABSTRACT 

TITTLE: JOULE EFFECT WHEN APLYING RADIOFREQUENCY IN AQUEOUS 

IMMERSED METAL NANO-PARTICLES3 

 

AUTOR: JORGE ANDRÉS MIDEROS ARBOLEDA4 

 

KEY WORDS: Metal nano-particles, radiofrequency electromagnetic field, joule 

effect, multiphysics numerical simulation. 

 

DESCRIPTION: In the following bachelor thesis, it will be presented the theory of 

electromagnetic fields and joule’s law. Based on this theory, it will be developed 

some numeric simulations of an aqueous solution that includes one or more metal 

spheres while it is applied a radiofrequency field. A thermal analysis will be done 

from the parametric sweep of the sphere’s concentration level and its size. The 

working basis will be the scientific literature related with the effect of the 

radiofrequency electromagnetic fields over the heating up of solutions that contain 

metal nanoparticles. The simulation process will be done with the commercial 

software CST Studio Suite (Computer Simulation Technology) in the multiphysics 

environment, to describe the phenomenon of the electromagnetic field and the 

thermal variation, by using Maxwell and thermal diffusivity equations, respectively. 

The linkage of both group of equations is realized through the calculation of the 

electromagnetic energy loss. These results would be interesting for future biomedical 

engineering researches such as: the hyperthermic treatment of cancer cells that 

would complete other treatments like chemotherapy and radiotheraphy, fast 

therapies in muscle injuries for athletes and other rheumatic conditions. 

                                            

3 Bachelor thesis 
4 Faculty of Physic-mechanical Engineering. School of Electrical, Electronic and 
Telecommunications Engineering. Director: PhD. Engineering Ernesto Aguilera Bermúdez. 



 15 

INTRODUCCIÓN 

De acuerdo con la perspectiva histórica que expone Vera5, una aplicación médica 

de la interacción de campos electromagnéticos con la materia se da en el 

tratamiento del cáncer, donde el objetivo principal es la manifestación de hipertermia 

para la destrucción de las células cancerígenas. Este fenómeno se describe como 

el aumento de la temperatura corporal por encima del valor estándar y, según las 

aplicaciones presentadas por Chichet6, se puede generar artificialmente en un área 

específica con métodos invasivos o no-invasivos. 

Como ejemplo de métodos no-invasivos, se encuentra en la literatura trabajos como 

el de Cheong7, quien presenta el uso de Luz Infrarroja Cercana (NIR por sus siglas 

en inglés) reforzado con nano-partículas de oro, o el de Thomas8, quien presenta el 

uso de campos magnéticos alternos para el calentamiento de nano-partículas de 

óxido de hierro. Sin embargo, este tipo de tratamientos manifiestan algunas 

desventajas para su implementación. Por ejemplo, según Martín9, la Luz NIR 

(aproximadamente entre 800 nm y 950 nm de longitud de onda) se emplea 

únicamente para tratamiento de tejidos subcutáneos, es decir, no es efectiva en 

tejidos más profundos, debido a su dispersión y atenuación en este medio. Por otro 

lado, teniendo en cuenta el trabajo realizado por Hergt10, aunque los campos 

magnéticos son efectivos para tratar tejidos profundos, en el proceso de 

calentamiento las nano-partículas de óxido de hierro presentan una baja pérdida de 

                                            

5 VERA HERNÁNDEZ, Arturo, et al. “Hipertermia electromagnética, una alternativa para el tratamiento del cáncer: 

antecedentes, aspectos físicos y biológicos”. En: Revista Mexicana de Ingeniería Biomédica; Vol. XXII, No. 2 (abril-septiembre 
2001); pp. 78 – 88 
6 CHICHET, Adam, et al. “Hyperthermia – description of a method and a review of clinical applications”. En: Reports of Practical 

Oncology and Radiotherapy; Vol. 12, No.5, 2007; pp. 267-275 
7
 CHEONG, Seong-Kyun; KRISHNAN, Sunil & CHO Sang H. “Modeling of plasmonic heating from individual gold nanoshells 

for near-infrared laser- induced thermal therapy”. En: Medical Physics; Vol. 36, 2009; pp. 4664–4671. DOI: 10.1118/1.3215536 
8 THOMAS, Reju; PARK, In-Kyu & JEONG, Yong Yeon. “Magnetic Iron Oxide Nanoparticles for Multimodal Imaging and 

Therapy of Cancer”. En: International Journal of Molecular Sciences, Vol. 14 (8), 2013; pp. 15910-15930. DOI: 
10.3390/ijms140815910 
9
 MARTÍN CORDERO, Jorge E. “Agentes Físicos Terapéuticos”. La Habana: Editorial Ciencias Médicas, 2008; pp. 421-422 

10 HERGT, Rudolf; et al. “Maghemite nanoparticles with very high AC-losses for application in RF-magnetic hyperthermia”. 

En: Journal of Magnetism and Magnetic Materials, Vol. 270 (3), 2004; pp. 345–357. DOI: 10.1016/j.jmmm.2003.09.001 
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energía específica (~600 W/g con un campo magnético de ~11 kA/m de amplitud), 

lo que implica que se requeriría aumentar su concentración a un nivel más alto del 

que se puede lograr dentro de un organismo. 

Una alternativa para vencer las limitaciones mencionadas, consiste en el 

calentamiento de nano-partículas metálicas inmersas en una solución acuosa 

empleando un campo de radiofrecuencias. Entre los trabajos que abordan esta 

solución hay algunos, como el de Glazer11, donde sólo realiza un procedimiento 

experimental para vincular los resultados con las ventajas de este método. 

Adicionalmente, en otros estudios, como el de Moran12, se analiza cuál es el 

mecanismo encargado del calentamiento de la solución acuosa con nano-partículas 

metálicas. Moran13 plantea que el calentamiento es consecuencia del efecto de la 

Ley de Joule y esto lo constata mediante un procedimiento experimental y un 

soporte teórico. Con base en este planteamiento, se desarrolló el presente trabajo 

de grado. 

Los resultados obtenidos en este trabajo de grado serían de interés para posteriores 

investigaciones en ingeniería biomédica en áreas como: el tratamiento hipertérmico 

de células cancerígenas que complementa otros tratamientos como la quimioterapia 

y la radioterapia; las terapias rápidas para el tratamiento de lesiones musculares en 

atletas; y el tratamiento de determinadas condiciones reumáticas.  

Actualmente se desarrollan trabajos que permiten la caracterización 

electromagnética de soluciones con nano-partículas metálicas, en colaboración con 

grupos de investigación de las Escuelas de Química, Ingeniería Química de la 

Universidad Industrial de Santander y el grupo de Investigación RadioGIS. 

                                            

11 GLAZER,
 
Evan S. & CURLEY, Steven A. “Non-invasive radiofrequency ablation of malignancies mediated by quantum 

dots, gold nanoparticles and carbon nanotubes”. En: Therapeutic Delivery, Vol. 2 (10), 2011; pp. 1325–1330. 
PMCID: PMC4090036 
12 MORAN, Christine H.; et al. “Size-Dependent Joule Heating of Gold Nanoparticles Using Capacitively Coupled 

Radiofrequency Fields”. En: Nano Research, Vol. 2 (5), 2009; pp. 400-405. DOI: 10.1007/s12274-009-9048-1 
13 MORAN Op. cit. p. 403. 
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1. GENERALIDADES DEL PROYECTO 

1.1 DESCRIPCIÓN DEL PROYECTO 

1.1.1 Formulación del problema. Uno de los retos en el tratamiento del cáncer 

con campos de radiofrecuencias utilizando nano-partículas metálicas es la 

definición del nivel de temperatura y del tiempo necesario de exposición al campo 

de radiofrecuencias. Debido a lo anterior, es importante comprender el mecanismo 

de calentamiento de las nano-partículas antes de poder establecer las 

características geométricas, electromagnéticas y térmicas que ayudan a cumplir 

estas condiciones en el tratamiento. 

Entre los mecanismos planteados en la literatura, en Moran14 se resalta el efecto de 

la Ley de Joule en las nano-partículas metálicas y la dependencia relacionada con 

la concentración de las nano-partículas y su tamaño. 

De esta manera, tomando como referencia los resultados obtenidos por Moran15 y 

la aproximación de las ecuaciones de Maxwell para el análisis en baja frecuencia16, 

se desea comprobar el efecto de la Ley de Joule como mecanismo de 

calentamiento, empleando como estrategia de análisis el desarrollo de unas 

simulaciones numéricas y tomando como referencia el procedimiento experimental 

en el trabajo de Moran 17. 

1.1.2 Objetivo general. Evaluar mediante simulaciones numéricas el efecto de un 

campo electromagnético de radiofrecuencias en el calentamiento por efecto Joule 

de nano-partículas metálicas inmersas dentro de una solución acuosa. 

                                            

14
 MORAN. Op. cit. pp. 402-404. 

15 Ibíd. 
16 MAKAROV, Sergey N.; Noetscher, Gregory M. & Nazarian, Ara. “Low-Frequency Electromagnetic Modeling for Electrical 

and Biological Systems Using MATLAB®”. Hoboken, New Jersey: John Wiley & Sons, 2016; pp. 8-9. 
17 MORAN. Op. cit. pp. 401-402. 
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1.1.3 Objetivos específicos. El cumplimiento del objetivo general del trabajo de 

grado comprende: 

 Determinar las características geométricas, electromagnéticas y térmicas del 

sistema, el cual incorpora al modelo de nano-partículas metálicas inmersas 

dentro de una solución acuosa y al campo electromagnético de 

radiofrecuencias, según sus propiedades físicas y con base en los valores 

presentados en la literatura científica. 

 Realizar en CST Studio Suite unas simulaciones numéricas multifísicas del 

modelo, que acople la incidencia del campo electromagnético de 

radiofrecuencias y los resultados de su comportamiento térmico. 

 Analizar los resultados del comportamiento térmico del caso de estudio, con 

respecto a la variación de los parámetros que involucran al mecanismo de 

calentamiento por efecto Joule. 

1.2 MARCO TEÓRICO 

1.2.1 Efecto de la Ley de Joule. La descripción del mecanismo de calentamiento 

por el efecto de la Ley de Joule comienza cuando se considera que existe una nano-

partícula metálica de cierto tamaño, 𝒅, expuesta a un campo electromagnético de 

baja frecuencia, 𝒇 = 𝝎/(𝟐𝝅) y su correspondiente longitud de onda, 𝝀. De esta 

manera, las ecuaciones de Maxwell, que describen el fenómeno del campo 

electromagnético en la nano-partícula, se les realiza una aproximación estática para 

el análisis en baja frecuencia, es decir, despreciando las derivadas en el tiempo 

cuando se cumple la siguiente condición 18: 

𝑑 ≪ 𝜆, 𝜆 ≡
𝑐

𝑓
, 𝑐 =

1

√𝜇𝜀
 (1) 

                                            

18 MAKAROV. Op. cit., p. 8. 
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A partir de esta aproximación y tomando en cuenta las ecuaciones de Poisson, 

Laplace y las condiciones de frontera de Neumann entre las superficies de dos 

medios, se establece que el campo eléctrico normal es discontinuo en la frontera 

entre dos medios de diferente conductividad, lo cual representa la existencia de una 

densidad de cargas libres 𝜎𝑆(𝒓), en la superficie de frontera. Considerando el campo 

eléctrico 𝑬(𝒓) en un punto de observación 𝒓 en la superficie de frontera de cada 

nano-partícula, se obtiene una densidad de corriente eléctrica, 𝒋(𝒓) =  𝜎𝑙𝑜𝑐𝑎𝑙𝑬(𝒓), 

donde 𝜎𝑙𝑜𝑐𝑎𝑙 es el valor local de la conductividad en el punto de observación. De 

esta manera es posible calcular la densidad de fuente de calor 𝑝𝑣 y 𝑝𝑠, por unidad 

de volumen y unidad superficial respectivamente, mediante las siguientes fórmulas 

que se presentan en el manual de usuario del software CST Studio Suite 19: 

𝑝𝑣 = 𝜋𝑓 tan(𝛿) 𝜀0𝜀𝑟 ∫|𝑬|2 𝜕𝑉 (2) 

𝑝𝑠 =
1

2
√

𝜋𝜇𝑓

𝜎
∫|𝑯𝒕𝒂𝒏|2𝜕𝑆 (3) 

Estos valores permiten el cálculo de la potencia disipada por las nano-partículas, 

cuando se aproximan como conductores de sección transversal constante 20: 

𝑃 = 𝐼2𝑅 (4) 

Por otra parte, este cálculo se puede obtener en función del diámetro de las nano-

partículas 𝑑, su conductividad 𝜎(𝜔), su área de sección transversal 𝑎 y la magnitud 

del campo eléctrico |𝑬| 21: 

𝐼2𝑅 = 𝜎(𝜔) ∗ [𝑎 ∗ 𝑑 ∗ |𝑬|2] (5) 

                                            

19 CST Support Team. CST Studio Suite 2017 Help. [Manual de usuario]. Home / 3D Simulation / Post Processing / Post 

Processing Results / Loss and Q Calculation Overview [2017] 
20 MORAN. Op. cit. p. 403. 
21 Ibíd. 
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El valor de la potencia disipada es útil para evaluar la razón de cambio de 

temperatura con respecto a la variación del tiempo en función de la cantidad de 

nano-partículas metálicas inmersas en una solución acuosa 𝑛, el volumen de la 

suspensión 𝑣 y la capacidad calorífica del agua 𝑐𝑤 22: 

𝑑𝑇

𝑑𝑡
=

[𝜎(𝜔) ∗ [𝑎 ∗ 𝑑 ∗ 𝐸2]]

𝑣 ∗ 𝑐𝑤
∗ 𝑛 (6) 

De esta manera, se puede observar que un mayor valor de la razón de cambio de 

temperatura, indica que se necesitará un tiempo menor para alcanzar un nivel de 

temperatura deseado y también, que a partir del modelo planteado existe una 

dependencia del aumento de temperatura en función del tamaño de las nano-

partículas y su concentración. 

1.2.2 Calentamiento del agua por efecto del campo electromagnético. Además 

del calentamiento por efecto Joule, es importante tomar en cuenta otros 

mecanismos que producen calentamiento en presencia de un disolvente como el 

agua y más aún, cuando no se considera la existencia de nano-partículas metálicas. 

Estos mecanismos, según Tang23, tienen efecto según el valor del factor de pérdidas 

dieléctricas, dependen de la frecuencia en la que se desarrolla el problema y pueden 

presentarse por superposición. 

Los dieléctricos se caracterizan por almacenar y disipar energía cuando están 

sujetos a un campo electromagnético. Este efecto sucede debido a las propiedades 

dieléctricas dadas por la permitividad dieléctrica relativa compleja 𝜀𝑟, la cual se 

compone por la permitividad dieléctrica relativa, 𝜀′ y el factor de pérdidas relativo, 

𝜀′′.  

                                            

22 MORAN. Op. cit. p. 404. 
23 TANG, Juming; HAO, Feng & LAU Ming. “Microwave heating in food processing”. Department of Biological Systems 

Engineering, Washington State University. Pullman, Washington. En: Advances in Bioprocessing Egineering, Vol. 1, Chapter 
1, 2002; pp. 1-44. DOI: 10.1142/9789812706584_0001 
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𝜀𝑟 = 𝜀′ − 𝑗𝜀′′ = |𝜀|𝑒−𝑗𝛿 (7) 

Estas dos componentes forman un ángulo de pérdidas dieléctricas, 𝛿, que se 

describe por medio de tangente de pérdidas dieléctricas: 

𝑡𝑎𝑛 𝛿 =
𝜀′′

𝜀′
 (8) 

Mientras 𝜀′ define la habilidad de un material para almacenar energía y de 

polarizarse por efecto de un campo eléctrico externo, el valor de 𝜀′′ determina la 

habilidad de convertir la energía eléctrica en energía térmica según varios 

mecanismos. Esta conversión puede ser calculada por la fórmula de Goldblith 24: 

𝑝𝑣 = 5.56𝑒−11 ∗ 𝑓 ∗ 𝜀′′ ∗ 𝐸2 (9) 

En la Figura 1, en la cual se presenta una gráfica bajo una escala logarítmica, se 

muestran los mecanismos de calentamiento por conducción iónica, por el efecto 

Maxwell-Wagner y por el efecto de relajación para el agua ligada y el agua libre. 

Como se puede observar en esta figura, los diferentes mecanismos contribuyen al 

valor del factor de pérdidas relativo, 𝜀′′, según la frecuencia de operación, siendo la 

conducción iónica y el efecto de relajación los mecanismos presentes en el rango 

de la radiofrecuencia. Es importante aclarar que el mecanismo por conducción 

iónica se manifiesta en soluciones salinas, mientras que el efecto de relajación para 

el agua ligada cuando hay alimentos que contienen agua y, por el contrario, el efecto 

de relajación para el agua libre cuando esta es el único material presente. 

                                            

24 GOLDBLITH, Samuel A. “Basic principles of microwave and recent developments”. Contribution Nº 889 Department of 

Nutrition and food science. Massachusetts Institute of Technology. Cambridge, Massachusetts. En: Advances in Food 
Research, Vol. 15, 1966; pp. 277-301. PMID: 4860243 
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Figura 1. Contribución de los mecanismos de calentamiento al factor de pérdidas 

debido a la frecuencia de operación.25 

Según Chaplin26, el efecto de relajación del agua libre se manifiesta por el fenómeno 

de polarización del agua en presencia de un campo electromagnético. Cuando este 

campo oscila, esto produce que las moléculas de agua se reorienten según la 

polaridad y al haber un retraso temporal entre la reorientación y la oscilación del 

campo, esto conlleva a un rozamiento molecular y a una pérdida de energía por 

calentamiento. El tiempo que determina el retraso o tiempo de relajación, 𝜏, se 

calcula mediante la siguiente fórmula: 

𝜏 =
4𝜋𝜂𝑟3

𝑘𝑇
 (10) 

                                            

25 TANG. Op. cit, p. 3. 
26 CHAPLIN, Martin. Water and Microwaves. [En línea]. Water Structure and Science. Este trabajo es licenciado con 

Creative Commons Atributions-Noncommercial-No Derivative Works 2.0 UK: England & Wales License. (Actualizado el 6 de 
noviembre de 2017) (Consultado en diciembre 2017) Disponible en http://www1.lsbu.ac.uk/water/microwave_water.html 
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Donde 𝑟 es el radio molecular, 𝑘 es la constante de Boltsmann, 𝜂 es la viscosidad 

del material y 𝑇 es la temperatura. Para el agua a 25ºC, 𝜏 tiene un valor de 8.27 ps.  

En la Figura 2, en la cual se presenta una gráfica bajo una escala logarítmica en el 

eje de las abscisas, se muestran únicamente valores para el efecto de relajación del 

agua libre. En rojo se relacionan los valores aproximados de la permitividad 

dieléctrica relativa y en azul el factor de pérdidas relativo según la correspondiente 

frecuencia de operación o la longitud de onda. Adicionalmente, para cada gráfica se 

presenta un barrido paramétrico respecto a la temperatura, presentándose una 

disminución de los valores mencionados con respecto al aumento de temperatura. 

 

Figura 2. Variación del valor de la permitividad dieléctrica relativa y el factor de 

pérdidas relativo con respecto a la frecuencia de operación y la temperatura.27 

                                            

27 Ibíd. 
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2. CONFIGURACIÓN DE LAS SIMULACIONES EN CST 

CST Studio Suite es una plataforma que está compuesta por diferentes módulos de 

simulación, en los cuales es posible desarrollar modelos en 3D de procesos que 

involucren fenómenos físicos. Teniendo en cuenta la descripción del mecanismo de 

calentamiento por efecto de la Ley de Joule, se puede observar que están presentes 

fenómenos de tipo electromagnético y de difusión térmica. Por medio de esta 

plataforma computacional se realizó la configuración de las simulaciones a partir de 

la diferenciación de estos fenómenos en dos ambientes de simulación, uno 

electromagnético y otro térmico. De esta manera, fue necesario crear un proyecto 

principal en CST que actuó como puente de comunicación entre los ambientes 

mencionados, a partir de una simulación multifísica. 

A continuación, se describe la configuración realizada en CST para cada uno de 

dichos ambientes.  

2.1 DEFINICIÓN DEL PROYECTO PRINCIPAL 

En esta etapa se creó un proyecto principal en CST desde el módulo 3D Simulation 

> High Frequency, en el cual se definieron unos aspectos generales, se realizó la 

descripción del modelo en 3D de las partículas inmersas en una solución acuosa y, 

por último, la configuración de la simulación multifísica.  

2.1.1 Aspectos generales. Esta configuración comprende la definición de las 

unidades de medida, del material del medio ambiente y del rango de frecuencias. 

En la Tabla 1 se muestran las unidades empleadas para representar los resultados 

de las simulaciones; estas se configuran desde la ventana principal del proyecto 

principal siguiendo la ruta desde la pestaña Home > Settings > Units. 
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Variable Unidad Abreviación 

Dimensiones Centímetros cm 

Temperatura Celsius ºC 

Frecuencia Megahertz MHz 

Tiempo Segundos s 

Voltaje Voltios V 

Corriente Amperios A 

Resistencia Ohm  

Conductancia Siemens S 

Capacitancia Picofarads pF 

Inductancia Nanohenries nH 

Tabla 1. Unidades para los resultados de las simulaciones. 

Por otro lado, en la Tabla 2 se describen las propiedades del aire, material del medio 

ambiente en el que se desarrollaron las simulaciones. Para realizar esta 

configuración se ingresa por la ruta de la pestaña Modeling > Materials > 

Background. Una vez dentro de la ventana de configuración, se sigue a Properties 

> Copy Properties from Material para proporcionar las propiedades del aire al medio 

ambiente de simulación. 

Propiedad del aire Valor 

Permitividad eléctrica () 1.00059 

Conductividad térmica 

W/K/m 
0.026 

Capacidad calorífica kJ/K/kg 1.005 

Tabla 2. Propiedades del aire.28 

Adicionalmente, en la Tabla 3 se muestran dos rangos de frecuencias que se 

tuvieron en cuenta para realizar el proceso de simulación, esta configuración se 

realiza siguiendo la pestaña Simulation > Settings > Frequency. Es importante 

                                            

28 CST Studio Suite 2017 [Software]. Material Library [2017] 
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resaltar que sin esta configuración no es posible realizar el proceso de mallado para 

el cálculo de los resultados e igualmente, definir un rango de frecuencia amplio o 

reducido produce que el tiempo de simulación disminuya o aumente 

respectivamente. El primer rango que se muestra en la tabla tiene una diferencia de 

sólo ±0.5 MHz de la frecuencia de simulación de 13.56 MHz 29, mientras que el 

segundo rango cuenta con una diferencia de ±10MHz. 

Frecuencia mínima Frecuencia máxima 

13.06 MHz 14.06 MHz 

3.56 MHz 23.56 MHz 

Tabla 3. Rango de frecuencias. 

Con el fin de seleccionar un rango de frecuencias, se realizaron dos simulaciones 

de prueba con su respectivo rango y empleando el modelo del caso de estudio 1, el 

cual se presentará en el siguiente capítulo. Teniendo en cuenta que ambas 

simulaciones se ejecutaron en el dominio del tiempo, se optó por analizar el tiempo 

de simulación. De esta manera, como el segundo rango de frecuencias es más 

amplio, esto contribuyó a que en el dominio temporal el procesamiento de la señal 

de excitación fuese de menor duración y por consiguiente se seleccionó el segundo 

rango para ejecutar las simulaciones correspondientes a los casos de estudio. 

2.1.2 Descripción del modelo de simulación. El modelo de simulación consiste 

en un recipiente cilíndrico de cuarzo (1 cm de diámetro, 1.5 cm de altura) que 

contiene ~1.5 mL de solución acuosa 30. El espesor del recipiente se definió de 0.05 

cm y en el interior de la solución acuosa se modelaron partículas de diferentes 

materiales (oro, cobre o madera) y tamaño según cada caso de estudio, los cuales 

se presentarán más adelante. De esta forma, en la Tabla 4 se relacionan los 

                                            

29 MORAN. Op. cit. p. 401. 
30 Ibíd. 
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materiales empleados en el modelo de simulación. Para configurar estos materiales 

se sigue la ruta desde la pestaña Modeling > Materials > Material Library > Load 

from Library. 

Asimismo, en la Figura 3 se presenta un modelo del caso de estudio 3, el cual se 

presentará más adelante y corresponde a un recipiente que contiene la solución 

acuosa con una partícula de oro. Para poder modelar cada uno de los sólidos según 

corresponda con cada caso de estudio, se utilizan las herramientas que se 

encuentran en la pestaña Modeling > Shapes/Tools. 

Material Cuarzo Agua Oro Cobre Madera 

Permitividad relativa (𝜺𝒓) 3.75 78 - - 2.689 

Conductividad eléctrica S/m 0.0004 1.59 4.561e7 5.8e7 - 

Conductividad térmica 

W/K/m 
5 0.6 314 401 0.2 

Capacidad calorífica kJ/K/kg 0.7 4.2 0.13 0.39 2 

Densidad kg/m3 2200 998.6 19320 8930 500 

Tabla 4. Materiales del modelo de simulación.31 

 

Figura 3. Modelo con partícula de oro para el caso de estudio 3. 

                                            

31 CST Studio Suite 2017 [Software]. Material Library [2017] 
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2.1.3 Configuración de la simulación multifísica. Esta configuración permite 

enlazar las configuraciones de los aspectos generales y la geometría del modelo de 

simulación con los ambientes electromagnético y térmico; es decir, que estos 

ambientes son creados en sub-proyectos de CST con una configuración previa y 

también, comparten el mismo modelo de simulación en 3D que se define en el 

proyecto principal. 

Además, se establece un vínculo unidireccional que parte desde el ambiente 

electromagnético en dirección al ambiente térmico, el cual enlaza el fenómeno 

electromagnético de pérdidas por efecto Joule con el fenómeno de difusión térmica. 

Esto indica que el proceso de simulación en el ambiente térmico dependerá de los 

resultados obtenidos en la simulación del ambiente electromagnético y no habrá 

dependencia en el sentido inverso.  

Para poder habilitar esta configuración hay que pasar a la ventana Schematic del 

proyecto principal, y seguir la ruta desde la pestaña Home > Simulation > Simulation 

Project > EM-Thermal Coupling > Uni-directional. Una vez habilitada esta 

configuración, se prosigue a crear cada uno de los sub-proyectos mencionados 

siguiendo la ruta desde la pestaña Simulation Project > Create Project > Create 

Simulation Project. En la Figura 4 se presenta la configuración que se realizó para 

crear el sub-proyecto del ambiente electromagnético, mientras que la Figura 5 

corresponde al sub-proyecto del ambiente térmico. 
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Figura 4. Configuración para creación del ambiente electromagnético. 

 

Figura 5. Configuración para creación del ambiente térmico. 

Por último, en esta configuración también se determina el valor de la frecuencia de 

simulación para la computación de las pérdidas de energía electromagnéticas 

(13.56 MHz 32), el factor de escala para estas pérdidas y se crean los monitores de 

                                            

32 MORAN. Op. cit. p. 401. 
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campo eléctrico, campo magnético y de pérdidas para obtener los resultados en el 

proceso de simulación, como se presenta en la Figura 6.  

 

Figura 6. Configuración para la computación de pérdidas electromagnéticas. 

2.2 DEFINICIÓN DEL AMBIENTE ELECTROMAGNÉTICO 

En esta etapa se creó un sub-proyecto en el módulo de simulación CST Microwave 

Studio, el cual está diseñado para simular problemas electromagnéticos en alta 

frecuencia. La configuración de este sub-proyecto está compuesta por la adición de 

nuevos componentes al modelo de simulación, la definición del mallado y las 

fronteras que delimitan al dominio computacional. Adicionalmente, el solucionador 

destinado para este proceso de simulación corresponde al Transitorio en el Dominio 

Temporal. 

2.2.1 Componentes adicionales al modelo de simulación. Además del modelo 

de simulación que se enlaza desde el proyecto principal, se añadieron dos placas 

paralelas de cobre circulares (15 cm de diámetro), ubicadas equidistantemente y 

centradas con el modelo de simulación (7.5 cm de distancia con el centro del 

modelo), tal como se muestra en la  
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2.2.2 Figura 7. Cabe resaltar, que el modelamiento de las placas se realiza de 

manera similar al de los demás solidos del modelo de simulación. 

  

Figura 7. Modelo de simulación con placas de cobre, cableado y fuente de voltaje en 

el ambiente electromagnético. 

De esta forma, las placas paralelas se alimentaron con una fuente de voltaje de 

2250 V la cual se puede configurar desde la pestaña Simulation > Sources and 

Loads > Discrete Port, y además, produce un campo electromagnético entre estas 

de ~15 kV/m con una señal de excitación Gaussiana (señal por defecto), la cual se 

presenta en la Figura 8. El valor de la fuente de voltaje se definió mediante la fórmula 

para el hallar el valor del potencial entre dos placas paralelas, 𝑉 = 𝑬 ∗ 𝑑; siendo 𝑑 

la distancia de separación entre las placas. Para lograr alimentar las placas se 

empleó la herramienta de cableado. 
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Figura 8. Señal de excitación Gaussiana. 

En la Figura 9 se puede observar el corte transversal de la intensidad de campo 

eléctrico generado entre las placas paralelas de 15 cm de diámetro. Adicionalmente, 

en la Figura 10 se obtiene la gráfica del valor absoluto de la intensidad de campo 

eléctrico medido entre las placas, a lo largo de una línea perpendicular al centro de 

las mismas, con un valor promedio de 15.22 kV/m. 

Con el fin de observar el resultado de la intensidad de campo eléctrico cuando el 

tamaño de las placas paralelas es mayor, se aumentó su diámetro a 60 cm, como 

se puede observar en la Figura 11. De esta manera, si se compara el resultado del 

valor absoluto del campo eléctrico medido entre las placas en la Figura 10 cuando 

las placas tienen un diámetro de 15 cm, con el resultado mostrado en la Figura 12 

cuando las placas tienen un diámetro de 60 cm, se puede observar que el campo 

es más uniforme y presenta un valor promedio de 15.18 kV/m; esto se atribuye a la 

relación entre la distancia de separación y el tamaño de las placas paralelas, en 

cuanto mayor sea el tamaño con respecto a la separación de las placas, es posible 



 33 

despreciar el efecto borde de las placas para considerar la uniformidad del campo 

eléctrico entre estas. 

 

Figura 9. Sección transversal del Campo Eléctrico entre las placas paralelas de 15 

cm. 

 

Figura 10. Valor Absoluto del Campo Eléctrico medido entre las placas de 15 cm. 
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Figura 11. Sección transversal del Campo Eléctrico entre las placas paralelas de 60 

cm. 

 

Figura 12. Valor Absoluto del Campo Eléctrico medido entre las placas de 60 cm. 

2.2.3 Configuración del mallado del ambiente electromagnético. Esta 

configuración corresponde con la discretización del dominio computacional para 

poder representar la solución a las ecuaciones de Maxwell, al realizar el proceso de 

simulación del ambiente electromagnético. La configuración del mallado cumple un 



 35 

papel importante en la simulación, que tiene consecuencias en la cantidad de datos 

a procesar y, por lo tanto, en el tiempo de ejecución y también, en la exactitud de 

los resultados. 

Para efectuar esta configuración se sigue la ruta desde la pestaña Simulation > 

Mesh > Global Properties. Se utilizará la configuración de una malla Hexaédrica, la 

cual divide el volumen computacional en cubos rectangulares que corresponden a 

cada celda del mallado. Cuantas más celdas de mallado se generen, más exacto 

será el cálculo de los campos electromagnéticos, pero también aumentará el tiempo 

de simulación y viceversa. En la Figura 13 se presenta una muestra de la vista de 

sección transversal del mallado del modelo de simulación en el ambiente 

electromagnético. 

 

Figura 13. Sección transversal del mallado en el ambiente electromagnético. 

2.2.4 Fronteras de simulación. Antes de dar inicio al solucionador Transitorio en 

el Dominio Temporal, se establecieron las fronteras de simulación, las cuales 

corresponden a los planos normales a los ejes cartesianos que encierran el dominio 

computacional. La configuración permite determinar entre una frontera eléctrica, 

magnética o abierta, y se puede realizar desde la pestaña Simulation > Settings > 

Boundaries. 
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Por un lado, la frontera eléctrica funciona como un conductor eléctrico perfecto, es 

decir, elimina la componente tangencial del campo eléctrico y la componente normal 

del campo magnético. De manera contraria, la frontera magnética actúa como un 

conductor magnético perfecto, de manera que elimina la componente normal del 

campo eléctrico y la componente tangencial del campo magnético. Por otro lado, la 

frontera abierta extiende la frontera hacia el infinito, es decir no impide el paso de 

ninguna componente de campo eléctrico o magnético y produce la más mínima 

reflexión de onda. En la Figura 14 se puede observar un ejemplo de las fronteras 

mencionadas, siendo la eléctrica de color verde, la abierta de color fucsia y la 

magnética de color azul. Para los casos de estudio que se presentarán más 

adelante, se realizó la configuración de todas las fronteras como tipo abierta. 

 

Figura 14. Ejemplo de las fronteras eléctrica, magnética y abierta 

2.3 DEFINICIÓN DEL AMBIENTE TÉRMICO 

Esta etapa se desarrolló en el módulo de simulación CST MPhysics Studio, el cual 

está diseñado para simular problemas de fenómenos térmicos y de mecánica 

estructural. La configuración de este sub-proyecto se compone de la definición de 

la señal de excitación, la definición del dominio computacional, sus fronteras y la 

configuración de los monitores que permiten la obtención de resultados. 
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2.3.1 Señal de excitación del sistema. Como señal de excitación se definió una 

señal constante de valor unitario, la cual se presenta en la Figura 15, tiene un tiempo 

de duración de 2 minutos33 y se configura desde la pestaña Simulation > Sources 

and Loads > Signal. De esta manera la señal va a excitar al sistema con los 

resultados de las pérdidas de energía electromagnética durante el tiempo 

determinado y con un factor de multiplicación unitario, con el fin de obtener la 

simulación del fenómeno de difusión térmica. 

 

Figura 15. Señal de excitación Constante unitaria. 

2.3.2 Definición del dominio computacional térmico y sus fronteras. Se definió 

una distancia de separación de 1 cm entre el modelo y las fronteras del dominio 

computacional térmico, con el fin de omitir el efecto de las placas paralelas de cobre 

en esta etapa y de igual manera, disminuir el tiempo de simulación. En este 

ambiente se pueden definir fronteras de tipo isotérmicas, adiabáticas o abiertas. 

Por un lado, las fronteras isotérmicas establecen un valor constante de temperatura 

en los límites del dominio computacional, mientras permiten el paso del flujo de 

                                            

33 MORAN. Op. cit. p. 402. 
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calor; estas se utilizan cuando el modelo se encuentra dentro de un ambiente de 

temperatura controlada. De manera contraria, las fronteras adiabáticas permiten la 

variación de temperatura en estos límites e impiden el paso del flujo de calor; estas 

se establecen cuando la estructura del modelo continúa después de la frontera, por 

ejemplo, cuando se emplean puertos de guía de onda. Por último, las fronteras 

abiertas permiten tanto la variación de temperatura, como el paso del flujo de calor; 

estas se emplean cuando se tiene espacio libre alrededor del modelo.  En la Figura 

16 se presentan un ejemplo de las fronteras mencionadas, siendo de color verde la 

frontera isotérmica, azul la adiabática y fucsia la abierta. Para los casos de estudio, 

se realizó la configuración de todas las fronteras de tipo abierta desde la pestaña 

Simulation > Settings > Boundaries. 

 

Figura 16. Ejemplo de las fronteras isotérmica, adiabática y abierta. 

2.3.3 Configuración de los monitores de temperatura. Se define un monitor 

para obtener la distribución de temperatura en todo el dominio computacional 

térmico; este se caracteriza por realizar la medición correspondiente, durante el 

tiempo establecido por la señal de excitación y se configura desde la pestaña 

Simulation > Monitors > Field Monitor. Como se puede observar en la Figura 17, se 

establece un delta de tiempo entre cada medición equivalente a 1 segundo, 

iniciando desde un tiempo inicial igual a 0 segundos. 
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Figura 17. Configuración del monitor de distribución de temperatura. 

Adicionalmente, se configuraron 3 monitores puntuales en diferentes coordenadas 

(x, y, z) medidas en centímetros, mediante los cuales se obtiene el valor de la 

temperatura durante el tiempo de simulación en cada uno de los puntos; estos se 

configuran desde la pestaña Simulation > Monitors > Monitor at Point. Se escogieron 

las coordenadas (0, 0, 0), (0.45, 0, 0) y (0.4, 0, -0.65) correspondientes al Monitor 

Central, el Monitor Extremo Central y el Monitor Extremo Inferior del modelo 

respectivamente; estas se pueden observar en la Figura 18. 

 

Figura 18. Monitores de temperatura para diferentes coordenadas. 

Monitor Central 
Coordenada 
 (0, 0, 0) 

Monitor Extremo Central 
Coordenada  
(0.45, 0, 0) 

Monitor Extremo Inferior 
Coordenada  
(0.4, 0, -0.65) 
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3. RESULTADOS 

Teniendo en cuenta las configuraciones realizadas para cada ambiente de 

simulación, se varió el tamaño de las partículas, su material y su concentración en 

la solución acuosa para obtener los resultados de los casos de estudio que se 

presentan a continuación. 

3.1 CASO DE ESTUDIO 1: MODELO DE CONTROL 

3.1.1 Descripción. Para el primer caso de estudio se realizó la construcción del 

modelo de simulación conformado únicamente por el recipiente de cuarzo y el agua 

en su interior, como se puede observar en la Figura 19. 

 

Figura 19. Modelo de control sin partículas. 

3.1.2 Resultados en el ambiente electromagnético. En la Figura 20 se puede 

observar que, según la escala de medición en V/m, hay atenuación de la intensidad 

de campo eléctrico en el espacio cercano al modelo de control y en su interior, como 

era de esperarse de acuerdo al fenómeno de polarización del agua. Según Purcell34, 

este fenómeno sucede cuando se somete la muestra a un campo eléctrico uniforme 

creado entre las placas paralelas, 𝑬𝟎. De esta manera, en el espacio próximo a la 

                                            

34 PURCELL, Edward M. “Electricidad y magnetismo, Berkeley physics course – Volumen 2” Edición en español, Barcelona: 

Editorial Reverté, 1988. pp. 368, 369 
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muestra el campo eléctrico dependerá de  𝑬𝟎 y de un campo 𝑬′ debido al agua 

polarizada, teniendo como resultado: 

𝑬 = 𝑬𝟎 + 𝑬′ (11) 

Considerando que la polarización se presenta de manera uniforme al interior de la 

muestra, 𝑬′ se puede expresar como: 

𝑬′ = −
𝑷

3𝜀0
 (12) 

y teniendo en cuenta que se debe cumplir que 𝑷 = 𝜒𝑒𝑬 = 𝜀0(𝜀 − 1)𝑬, se puede 

hallar la siguiente relación entre el campo uniforme 𝑬𝟎 y el campo próximo a la 

muestra, 𝑬: 

𝑬 = 𝑬𝟎 −
𝑷

3𝜀0
= 𝑬𝟎 −

𝜀 − 1

3
𝑬 (13) 

𝑬 = (
3

2 + 𝜀
) 𝑬𝟎 (14) 

Como el valor 𝜀 tiene un valor mayor que la unidad, esta relación indica que el 

campo 𝑬 será menor que el campo generado entre las placas paralelas. 

Adicionalmente, se realiza un corte transversal de la muestra y se representa la 

magnitud de las pérdidas por efecto del campo eléctrico en la Figura 21. De acuerdo 

a esta gráfica en dos dimensiones se registra un valor máximo de pérdidas de 346 

kW/m3 en el agua el espacio central del modelo, es decir, en este espacio el efecto 

de relajación ocasiona que, por la reorientación de la polaridad de cada molécula 

de agua, haya mayor rozamiento molecular y por consiguiente mayores pérdidas. 
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Figura 20. Sección transversal del Campo Eléctrico en el modelo de control. 

 

Figura 21. Perfil de pérdidas electromagnéticas en el modelo de control. 

3.1.3 Resultados en el ambiente térmico. Los valores calculados de las pérdidas 

se importan en el ambiente térmico para excitar al sistema y de esta manera obtener 

el aumento de la temperatura del modelo según el tiempo de simulación, como se 

presenta en el Anexo A. Adicionalmente, se obtienen las curvas de variación de 

temperatura de los tres monitores puntuales configurados según la sección 2.3.3, 

las cuales se muestran en la Figura 22. De la misma manera, se presenta una 

temperatura máxima (Tmáx.) de ~31.25 ºC, ~30.50 ºC y ~30.12 ºC en los monitores 

Central, Externo Central y Externo Inferior respectivamente. 
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Figura 22. Temperatura medida en el modelo de control. 

3.2 CASO DE ESTUDIO 2: PARTÍCULAS DE 0.8 CENTÍMETROS DE DIÁMETRO 

3.2.1 Descripción. En este caso de estudio se realiza la descripción de un modelo 

de simulación que contiene una partícula de 0.8 cm de diámetro y para la cual se 

varia su material de composición entre oro, cobre y madera. Para cada modelo de 

diferente material, se realiza el procedimiento de simulación que se ejecutó en el 

caso de estudio de control. En la Figura 23 se puede apreciar una muestra del 

modelo con una partícula de oro, correspondiente al presente caso de estudio. 

 

Figura 23. Modelo con una partícula de oro 0.8 cm de diámetro. 
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3.2.2 Resultados en el ambiente electromagnético. Como primer resultado, se 

obtiene el perfil de campo eléctrico para cada partícula de diferente material, como 

se muestra en la Figura 24. La escala de medición de estos resultados se establece 

con un límite superior de 15 kV/m y el corte transversal para estos resultados se 

realiza en el centro del modelo de simulación. Como se puede observar en esta 

figura, no hay campo eléctrico al interior de las partículas metálicas de oro y cobre, 

mientras que en la partícula de madera si hay presencia de campo eléctrico en su 

interior debido a su naturaleza dieléctrica. 

  

Oro Cobre 

 
Madera 

Figura 24. Sección transversal del Campo Eléctrico en los modelos con partículas 

de 0.8 cm de diámetro. 

Por otro lado, para los modelos de las partículas conductoras de oro y cobre, 

también se obtuvieron los resultados de la densidad de corriente superficial inducida 

que se muestran en la Figura 25. Es importante aclarar que en esta figura los 
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vectores cuya magnitud se mide en unidades de A/m, forman una esfera, es decir 

no se encuentran dentro de la partícula sino en la superficie frontal a la figura. 

Adicionalmente, en la superficie lateral derecha de ambas esferas se evidencia una 

mayor densidad corriente superficial siendo de magnitud 2.904 A/m para el Oro y 

2.907 A/m para el cobre. Esta figura se obtuvo en la fase en que el campo eléctrico 

generado entre las placas es mínimo y el campo magnético es máximo. Por último, 

es importante agregar que la fuente que alimenta las placas paralelas se posiciona 

hacia la derecha, influyendo en la densidad de corriente inducida sobre las esferas 

por medio del campo magnético. 

  

Oro Cobre 

Figura 25. Corriente superficial en las partículas conductoras. 

Al igual que con el caso de estudio del modelo de control, también se obtuvieron los 

perfiles de las pérdidas volumétricas que se presentan en la Figura 26 y se registran 

unos valores máximos de estas pérdidas de 983 kW/m3, 974 kW/m3 y 4.29 MW/m3 

en los modelos con partículas de oro, cobre y madera respectivamente. Según los 

resultados de esta figura, es importante observar que el mayor valor de pérdidas en 

el modelo con las partículas metálicas de oro y cobre se ubica en los extremos 

superior e inferior de estas, mientras para el modelo con la partícula de madera este 

valor se encuentra en los costados y, además, que estos valores no están presentes 

dentro de las partículas, sino en el agua que se sitúa alrededor de estos puntos. 
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Oro Cobre 

 
Madera 

Figura 26. Perfil de pérdidas electromagnéticas en los modelos con partículas de 

0.8 cm de diámetro. 

3.2.3 Resultados en el ambiente térmico. Siguiendo el mismo procedimiento 

realizado para el caso de estudio de control, en la Figura 27 se presentan los 

resultados correspondientes a la medición de temperatura en cada uno de los 

monitores puntuales configurados según la sección 2.3.3. En las gráficas de esta 

figura también se presentan los valores de temperatura máximos medidos en cada 

monitor para cada modelo según la partícula de diferente material. Adicionalmente, 

en los anexos: Anexo B, Anexo C y Anexo D se presentan los perfiles de distribución 

de temperatura, según varía el tiempo de simulación, para los modelos del presente 

caso de estudio. Como se puede observar en las gráficas de la Figura 27, el modelo 

con la partícula de madera presenta la mayor diferencia de temperatura en el tiempo 

de simulación. 
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Monitor Central Monitor Extremo Central 

 
Monitor Extremo Inferior 

Figura 27. Temperatura medida en los modelos con partículas de 0.8 cm de 

diámetro. 
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3.3 CASO DE ESTUDIO 3: PARTÍCULAS DE 0.01 CENTÍMETROS DE 
DIAMETRO 

3.3.1 Descripción. El presente caso de estudio consiste en obtener los resultados 

de simulación respecto al aumento de la concentración de las partículas en la 

solución acuosa, manteniendo constante su tamaño.  

De esta forma, se incorporaron partículas de oro de un tamaño equivalente al grosor 

de un cabello (0.01 cm) en el modelo de simulación. Se comenzó insertando una 

sola partícula ubicada en el centro del modelo y se continuó aumentando la cantidad 

de partículas hasta llegar a 80, como se puede observar en la Figura 28. 

    

1 Partícula 20 Partículas 40 Partículas 80 Partículas 

Figura 28. Modelos con partículas de 0.01 cm de diámetro. 

3.3.2 Resultados en el ambiente electromagnético. De manera similar al caso 

de estudio de control, se obtuvo el perfil de pérdidas electromagnéticas debidas al 

campo eléctrico para cada modelo del caso de estudio, con su respectiva cantidad 

de partículas de 0.01 cm, como se puede observar en la Figura 29. Primeramente, 

es importante tener en cuenta que el valor de las pérdidas electromagnéticas dentro 

de las de las partículas metálicas es cero por la ausencia de campo 

electromagnético al interior. Igualmente, también cabe observar que, como el mayor 

valor de estas pérdidas se ubica alrededor de las partículas y, como el agua, siendo 

el dieléctrico presente en cada modelo, presenta pérdidas por efecto de relajación, 

es en estos puntos donde hay mayor rozamiento entre las moléculas de agua. 
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1 Partícula 20 Partículas 

  
40 Partículas 80 Partículas 

Figura 29. Perfil de pérdidas electromagnéticas en los modelos con partículas de 

0.01 cm diámetro. 

3.3.3 Resultados en el ambiente térmico. Teniendo en cuenta los resultados de 

las pérdidas electromagnéticas, se prosigue a obtener los resultados de 

temperatura siguiendo el mismo procedimiento de simulación que se realizó en el 

caso de estudio de control. Los perfiles de distribución de temperatura, según el 

tiempo de simulación, para cada uno de los modelos del presente caso de estudio 

se pueden observar en los anexos: Anexo E, Anexo F, Anexo G y Anexo H. 

En la Figura 30 se presentan las gráficas de la medición de temperatura para cada 

uno de los monitores puntuales, al igual que los valores de temperatura máxima 

medida en cada uno de ellos (Tmáx.). Cabe distinguir que, en estas gráficas, las 

líneas que representan el aumento de temperatura para modelo de control, en café, 

y para el modelo con una sola partícula, en verde, están ligeramente superpuestas. 
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Adicionalmente, se puede observar una correspondencia de mayores valores de 

temperatura cuando hay mayor cantidad de partículas y menores valores de 

temperatura cuando la cantidad es menor. 

  
Monitor Central Monitor Extremo Central 

 
Monitor Extremo Inferior 

Figura 30. Temperatura medida en los modelos con partículas de 0.01 cm de 

diámetro. 
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4. ANÁLISIS DE LOS RESULTADOS 

4.1 MODELO DE CONTROL 

Analizando los resultados obtenidos a partir de la simulación del modelo de control 

en la Figura 20 y la Figura 21, se evidencia que, debido al efecto de relajación 

mencionado en la sección 3.1.2, se presentan pérdidas volumétricas y como 

consecuencia, se manifiesta un aumento de temperatura desde el centro del modelo 

de simulación, esto se puede comprobar en la Figura 22 observando que el monitor 

central presenta una temperatura máxima mayor que los demás monitores. 

Además, si se aplica una regresión lineal a las gráficas de la Figura 22 y luego se 

calcula su derivada con respecto al tiempo, se obtiene el valor de la pendiente que 

corresponde a la tasa de aumento de temperatura en el tiempo para cada monitor 

puntual; en la Tabla 5 se presentan dichos valores calculados. Asimismo, es posible 

indicar que para el modelo de control hay una tasa promedio de aumento de 

temperatura igual a 0.04573 ºC/s según los valores de los tres monitores puntuales. 

Monitores del 

modelo de control 
Monitor Central 

Monitor Extremo 

Central 

Monitor Extremo 

Inferior 
Promedio 

Tasa de aumento 

de temperatura 

ºC/s 

0.05366 0.04637 0.04253 0.04573 

Tabla 5. Tasa de aumento de temperatura en el modelo de control. 

Tomando como referencia los valores que se presentan en la tabla anterior, se 

realizará el análisis de los demás casos de estudio, teniendo también en cuenta que 

para estos casos se realizó una variación de concentración de la solución o del 

material por el que están compuestas las partículas. 

Adicionalmente, es importante resaltar que si se observa el perfil de pérdidas 

volumétricas de la Figura 21 y el perfil de variación de temperatura del Anexo A, se 

puede distinguir una correspondencia con la zona donde se concentra la mayor 

cantidad de pérdidas y la zona en donde empieza a aumentar la temperatura, lo 
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cual demuestra como las pérdidas volumétricas tienen gran relevancia en el 

aumento de temperatura. 

4.2 VARIACIÓN DEL MATERIAL EN LAS PARTÍCULAS DE 8 MILIMETROS DE 
DIÁMETRO 

Entre los resultados obtenidos en el presente caso de estudio, se cuenta con la 

intensidad de campo eléctrico que se observa en la Figura 24, en ella se muestra la 

sección transversal de este campo vectorial. A partir de este resultado se realizó el 

cálculo del valor absoluto de la intensidad de campo eléctrico al interior cada una 

de las partículas de diferente material, siguiendo una línea vertical que va desde el 

extremo superior hasta el extremo inferior de las partículas y tiene como longitud su 

diámetro, tal como se muestra en la Figura 31. Los valores hallados se presentan 

en la gráfica de la Figura 32. 

 

Figura 31. Representación de la línea donde se mide el valor absoluto de la 

intensidad de campo eléctrico al interior de una partícula. 

Adicionalmente, en la Figura 32 se muestra también el valor absoluto del campo 

eléctrico en el centro de las partículas, siendo 0 V/m en las partículas de oro y cobre 

y ~13.12 V/m en la partícula de madera. Cabe aclarar que las gráficas para los 

modelos con las partículas de oro y cobre, se encuentran superpuestas y, además, 

que según las mismas gráficas, el campo eléctrico no es completamente cero en 

todo el interior de las partículas, ya que se observa un ligero aumento de su valor 

en los extremos, lo cual evidencia penetración del campo eléctrico en dichas 

partículas metálicas. 
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Figura 32. Valor absoluto de la intensidad de campo eléctrico al interior de las 

partículas de 0.8 cm de diámetro. 

Por otro lado, se evaluó el valor de las pérdidas volumétricas en el interior de cada 

partícula, siguiendo la misma línea vertical de la Figura 31 mencionada 

anteriormente; este resultado se encuentra representado en la Figura 33. Como se 

puede observar en esta figura, el valor de pérdidas volumétricas no es nulo en el 

centro la partícula de madera, pero si lo es para las partículas de oro y cobre. Por 

otro lado, estas últimas presentan pérdidas volumétricas en los extremos superior e 

inferior debido a la leve penetración que tiene el campo eléctrico en este punto. 

Con respecto a los resultados en el ambiente térmico presentados en la Figura 27, 

correspondientes a la temperatura medida en los monitores puntuales, los modelos 

presentan diferentes tasas de aumento de temperatura, los cuales se muestran en 

la Tabla 6. Para el cálculo de estos valores se realiza el mismo procedimiento de 

regresión lineal y cálculo de la derivada efectuado para el modelo control en la 

sección anterior. 
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Figura 33. Valor de pérdidas al interior de las partículas de 0.8 cm de diámetro. 

Tasa de aumento 

de temperatura 

ºC/s 

Monitor Central 
Monitor Extremo 

Central 

Monitor Extremo 

Inferior 
Promedio 

Partícula de Oro 0.06125 0.06043 0.06642 0.06270 

Partícula de 

Cobre 
0.05724 0.05677 0.06386 0.05929 

Partícula de 

Madera 
0.20057 0.24073 0.17869 0.20666 

Tabla 6. Tasa de aumento de temperatura en los modelos de partículas de oro, 

cobre y madera de 0.8 cm de diámetro 

4.3 VARIACIÓN DE LA CONCENTRACIÓN DE PARTÍCULAS DE 0.01 
CENTÍMETROS DE DIÁMETRO 

Para los resultados del presente caso de estudio se representó la cantidad de 

partículas presentes en la solución con una unidad de concentración. De esta 

manera se realizó el cálculo de la fracción volumétrica del oro de acuerdo al cociente 

entre el volumen que ocupan las partículas de oro y el volumen total de la solución. 
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En la Tabla 7 se presentan los valores calculados para la concentración del oro en 

los modelos del caso de estudio. 

𝐹𝑟𝑎𝑐𝑐𝑖ó𝑛 𝑣𝑜𝑙𝑢𝑚é𝑡𝑟𝑖𝑐𝑎𝑜𝑟𝑜 =
𝑉𝑜𝑙𝑢𝑚𝑒𝑛 𝑑𝑒 𝑙𝑎𝑠 𝑝𝑎𝑟𝑡í𝑐𝑢𝑙𝑎𝑠 𝑑𝑒 𝑜𝑟𝑜

𝑉𝑜𝑙𝑢𝑚𝑒𝑛 𝑇𝑜𝑡𝑎𝑙
 (15) 

 
Cantidad de 

partículas 
1 20 40 80 

Fracción 

volumétrica [
𝒎𝟑

𝒎𝟑
] ×

𝟏𝟎−𝟔 

0.444 8.889 17.778 35.556 

Tabla 7. Concentración de oro en los modelos con partículas de 0.01 cm de 

diámetro. 

Adicionalmente, para cada uno de los valores de concentración se realizó el cálculo 

de la tasa de aumento de temperatura en los respectivos tres monitores puntuales 

y adicionalmente su promedio, siguiendo el mismo procedimiento realizado para el 

modelo de control.  De esta manera, en la Tabla 8 de presentan dichos valores 

calculados y en la Figura 34 se presenta la gráfica que relaciona el valor promedio 

de la tasa de aumento de temperatura con la concentración de oro. 

 
Tasa de aumento de temperatura en los monitores 

puntuales ºC/s Tasa de 

aumento de 

temperatura 

promedio ºC/s 

Fracción 

volumétrica 

𝒎𝟑

𝒎𝟑 × 𝟏𝟎−𝟔 

Monitor Central 
Monitor Extremo 

Central 

Monitor Extremo 

Inferior 

0.444 0.05284 0.04608 0.04250 0.04714 

8.889 0.08111 0.07082 0.06492 0.07229 

17.778 0.08547 0.07603 0.07151 0.07767 

35.556 0.09704 0.09272 0.10114 0.09697 

Tabla 8. Tasa de aumento de temperatura en los modelos con partículas de 0.01 cm 

de diámetro. 
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Figura 34. Tasa de aumento de temperatura promedio en relación con la 

concentración de oro. 
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5. CONCLUSIONES 

Tras haber desarrollado el proceso previo de configuración y posterior ejecución de 

las simulaciones, al igual que la obtención de los resultados para su análisis, se 

llegan a las conclusiones expuestas a continuación. 

Cuando se expone una muestra que contiene algún tipo de material, ante un campo 

de radiofrecuencias generado entre dos placas paralelas, hay manifestación de 

algún tipo de mecanismo que ocasiona el aumento de temperatura. Esto se 

evidencia en todos los casos de estudios aquí expuestos por medio de las gráficas 

presentadas en los Anexos y los resultados en el ambiente térmico 

correspondientes, tanto en las muestras compuestas por material dieléctrico, como 

aquellas que se componen por material dieléctrico y al menos una partícula 

metálica. Adicionalmente, haciendo una comparación entre las gráficas de pérdidas 

electromagnéticas y las presentadas en los Anexos, se evidencia una gran 

correspondencia de las zonas donde hay mayores pérdidas y las zonas donde hay 

mayor temperatura. 

A partir del caso de estudio del modelo de control, se comprueba la manifestación 

del efecto de relajación por la polarización de la muestra de agua, la cual se somete 

al campo eléctrico generado por las placas paralelas y el cual varía a una frecuencia 

determinada, en este caso, 13.56 MHz. Debido a esta manifestación la muestra se 

calienta a una tasa de temperatura 0.04573 ºC/s. 

Con respecto a la variación del material empleado para las partículas del caso de 

estudio 2, se puede evidenciar, a partir de las Figuras 32 y 33, que el campo eléctrico 

penetra en las partículas metálicas y debido a esta penetración se obtienen pérdidas 

volumétricas medidas en W/m3 por efecto joule. De acuerdo a las tasas de aumento 

de temperatura calculadas y presentadas en la Tabla 6, se tienen unos valores 

promedio de 0.06270 y 0.05929 ºC/s para los modelos con una partícula de oro y 

cobre de 0.8 cm, respectivamente. Sin embargo, aunque la manifestación del efecto 



 58 

joule es evidente, si se comparan estos últimos valores con la tasa de aumento de 

temperatura del modelo que contiene la partícula de madera de 0.8 cm, es evidente 

que la manifestación del efecto de relajación cuando se polariza este último modelo 

es mucho mayor, con un valor de 0.20666 ºC/s, es decir, casi 4 veces mayor. Por lo 

anterior, se puede decir que, en cuanto a efectos que producen aumento de 

temperatura, el efecto de relajación en los dieléctricos tiene mayor presencia que el 

efecto de joule, este último no aporta de manera significativa al aumento de 

temperatura, es decir, ambos efectos están presentes, pero es el efecto de 

relajación el más presente en los resultados. 

Sin embargo, no se puede excluir que efectivamente se puede obtener un aumento 

de temperatura de una solución acuosa que contiene partículas metálicas y esto se 

puede afirmar gracias al análisis de los resultados obtenidos en el caso de estudio 

3. De manera positiva, de acuerdo a la gráfica de la Figura 34, se obtiene una mayor 

tasa de aumento de temperatura conforme aumenta la concentración de partículas 

metálicas, llegando a obtener una tasa cercana al 0.1 ºC/s. Este resultado es 

relevante para analizar en aplicaciones, por ejemplo, médicas para el tratamiento 

de cáncer por hipertermia, en donde es importante entrar a analizar, en futuras 

investigaciones, factores adicionales como el tiempo de exposición a la 

radiofrecuencia o el límite máximo de concentración de partículas que puede 

suministrarse a un paciente. 
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ANEXOS 

Anexo A. Perfiles de variación de temperatura en el modelo de control. 
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Anexo B. Perfiles de variación de temperatura en el modelo con una partícula 

de oro. 
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Anexo C. Perfiles de variación de temperatura en el modelo con una partícula 

de cobre. 
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Anexo D. Perfiles de variación de temperatura en el modelo con una partícula 

de madera. 
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Anexo E. Perfiles de variación de temperatura en el modelo con 1 partícula 

de 0.01 cm de diámetro. 
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Anexo F. Perfiles de variación de temperatura en el modelo con 20 partículas 

de 0.01 cm de diámetro. 
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Anexo G. Perfiles de variación de temperatura en el modelo con 40 partículas 

de 0.01 cm de diámetro. 
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Anexo H. Perfiles de variación de temperatura en el modelo con 80 partículas 

de 0.01 cm de diámetro. 
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